Making a Photoshop Video: Actions, Batches and You

I've always wanted to combine some video action with the look of a pencil drawing or
the flatness of clip art. However, there were many roadblocks in my way. | certainly
couldn’t afford an animator to sit down and draw hundreds of images and didn’t have
the time to even consider tracing all the images myself.

| got a swift kick in my reality when | saw the U.S. TV commercials for Chuck Schwab
Investments. It looked as if a piece of clip art was moving as smoothly as video and |
was absolutely sure that they didn’t draw it frame by frame. But as it turns out, they
did do that, but through manual rotoscoping. Still, a very long process.
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This tutorial will teach you how to do a very similar thing. Using only Photoshop
actions, batches, Quicktime Pro and a short digitized video clip, you can accomplish
great results.

This project will take you through the 5 steps that will make a Photoshop video.
Step 1: Prepare the video by splitting it into individual files.

Step 2: Make an action, purchase an action or get free ones online, which
manipulates the image the way you want the image to look. In this tutorial, we'll
create a simple action step by step.

Step 3: Set-up Photoshop's Batch command.



Step 4: Run the Batch command.
Step 5: Combine the individual processed images back into a video file.

Along with using Photoshop, this project will require Quicktime Pro, which is a simple
and inexpensive upgrade to the free Quicktime player that is available cross platform
for both Mac and Windows.

OK, Lights! Camera! Action!

Step 1: Prepare the video file
Any video clip that you can save to your computer will work. | usually work with .mpg
video files or .mov movie files because they easily go in and out of Quicktime Pro.

Simply put, a digitized video that you see on your computer is nothing more than a
number of still images in sequence. Granted, it may be a large number of images,
but, none the less, they are still images. When you open the video in Quicktime Pro
you can export the entire video as individual jpg images with just one click.

First open your video file in Quicktime Pro.
Under the 'File' menu, select 'Export’
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From the dialog box that appears, choose 'Movie to Image Sequence' from the pop
up menu. This step will automatically convert the video into individual images.
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There are some options to select that will make you project easier to work with. Click
the 'Options..." button and select JPEG for the format.

When you select JPEG for the format, another 'Options..." button will become

available. Select the "Options..." and then select ‘Best Depth’ for the JPEG image
quality. This will help insure that the project produces the best results.
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After you click the ‘OK’ button you will need to select a frame rate.
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Select 29.97 Frames Per Second (FPS). You can use a lower number for the Frames
per Second. In fact, if you're planning to use the Photoshop video online or in a web
environment, 24 or 18 FPS will still provide a good effect.

At 30 FPS, Quicktime will make 30 still images for every second of video in the clip.
By using a lower number, fewer still images will be generated and ultimately provide
a smaller file size. However, note that with a higher number of FPS selected, a
smoother, more video-like effect will be achieved. I've used 24 FPS for the sample
movies created with this tutorial.
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One last, but important, tip for this step. Select the button to save these still images in
a ‘New Folder’. | once made the mistake of not selecting a folder and found about a
thousand JPEG images all over the desktop. Need | say more?



If there is audio on your video clip and you would want it in the final stylized video,
also do the following:

Under the 'Edit' menu, select 'Export' and choose 'Sound to AIFF'.

Save the file. This will be needed later on.
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Step 2: Making a Photoshop action which we will apply to all of the video still images.

We will create a simple action to demonstrate the 'How to create an action" process.
The true power of this tutorial is that you can use almost any Photoshop filter or
command and are not limited to the simple Action we’ll be creating. You can use any
of the numerous Photoshop Actions available online, free or for purchase, that can
manipulate an image to look the way you want. The two sample movies I've created
for this tutorial use the Pencil Pixels’ One-Click Actions. (www.PencilPixels.com)

These actions are made up of more complex steps than our tutorial action will
contain, but they achieve the look and feel of a pencil sketch and of a piece of poster
art. Most importantly, they demonstrate the real potential of this tutorial’s technique.

We need to make and use a Photoshop action because, like the Batch command that
we will be making later, it will allow us to duplicate a number of steps in a consistent
manner without the need to sit in front of the computer and hit buttons and move
sliders for hours on end.

If your Photoshop Actions palette is not open, select 'Actions' from the 'Window'
dropdown menu.


http://www.pencilpixels.com

You can start a new action in one of two ways.
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1) At the bottom of the Actions palette, you can select the 'new action' icon or,

2) by selecting 'New Action' from the pop-out menu, which is accessible from the
triangle button at the top right hand corner of the Actions palette. Name the Action
anything you would like. In this example I'll use the name ‘outline’.
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Click the record button and you can now do a number of manipulations to the image.
Photoshop will automatically record these steps exactly as performed.

To show an example of this, I'll go through the series of steps that | would want for
my ‘outline’ action.

From the main Photoshop menus at the top I'll select
‘Image’ - ‘Adjustments’ - ‘Desaturate’.



Next from the menu, I'll select

‘Layer’ - ‘Duplicate Layer...’

and leave the default name that appears in the dialog box (‘Background copy’).
| could also have made a duplicate layer by pressing the triangle button on the
top right of the ‘Layers’ palette and selected it from the pop-out menu.
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Now, with this new duplicate layer still selected, I'll select
‘Image’ - ‘Adjustments’ — ‘Invert’

From the Layer palette’s ‘Blend Mode’,
(or from ‘Layer’ - ‘Layer Style’ - ‘Blending options..." - ‘Blend Mode’)
select ‘Color Dodge’ from the dropdown.
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Lastly, from the Photoshop menu, select

‘Filter’ - ‘Blur’ - ‘Gaussian Blur...’

and select a value of 3 or so. By looking at the image, you can adjust the
amount of blur that makes the image appear like an outline.
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We have to add two more steps to make the action, that we've just created, work with
the batch command that we will be using.

First select ‘File’ - ‘Save As...".
From this dialog box, select ‘JPEG’ from the ‘Format’ dropdown box.
Click the ‘Save’ button and move the ‘Quality’ slider to 12 or ‘Maximum’.
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Click the ‘OK’ button.

Close the image window [Cmd w] on a Mac or [Ctrl w] on Windows.
A Photoshop alert box will ask to do: ‘Don’t Save’, ‘Cancel’ or ‘Save’.
Select the ‘Don’t Save’ button.
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You're almost finished with creating the Action. In order to end the recording of the
action, select the Square icon at the bottom left of the Actions palette
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or select ‘Stop Recording’, which is accessible from the pop-out menu on the Actions
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Just to check that we are on the same page so far, the image above shows
approximately how the effect on the image should look, how many steps in the
‘outline’ action there should be and how the two layers in the ‘Layers’ palette should
look.



Step 3: Let Photoshop use your action on all of the still images from the video by
using the Batch command.

From the Photoshop menu select ‘File’ - ‘Automate’ - ‘Batch...’, the following dialog
window will be displayed.
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First, select the action that you’ve named and created. In my example, I've created
the action called ‘outline’. (If the Action that you’ve just created is not automatically
displayed, select your action from the ‘Action:’ dropdown.) (1)

From the ‘Source:’ dropdown, select ‘Folder’ (2)

Click the ‘Choose’ button and select the folder that you’ve created for all the video
still images. (3)

Next there are four check boxes. By default, the first two should be unchecked and
the last two should be checked. (4)



From the ‘Destination:” dropdown, select ‘Folder’ (5)

Click the ‘Choose’ button and select the folder that you would like to save all of the
new images in. (6) When this dialog box opens, you most likely would want to store
the images in a new folder by clicking the ‘New Folder’ button. That is unless, if you
want a thousand image files on your desktop and want it as a new wallpaper.

For the ‘File Naming’ section | would use a name with just a few letters rather then a
name like “TheseAreTheStillsThatAreGoingToBeProcessed”

In the dropdown to the right, (7) select ‘4 Digit Serial Number’. This will give each still
image a unique sequence number for us to work with afterwards. If you have more
than 9999 images to process, select an additional serial sequence to be added to the
file name from one of the other dropdowns.

Lastly, make sure that the ‘Starting serial#:’ box indicates ‘1’ (8)

Step 4: Click the ‘OK’ button at the top of this dialog box and go have dinner.
When you come back, all the still images in the folder will have been processed with

the action. One last step and you can amaze your Photoshop and video friends.

Step 5: Combine all the individual images into a video. It's not as complex as it
sounds. Open Quicktime Pro and select ‘File’ - ‘Open Image Sequence...’
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A dialog box will appear, from it select the folder where the PROCESSED images are
located. Then select the first image (by name) in the series.
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After you click the ‘Open’ button, a dialog box will ask how many frames per second
(FPS) you want. You should use the FPS rate at which you extracted the images in
Step 1.
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Click ‘OK’ and Quicktime will assemble all the sequenced images together. Be sure
to save the file. I'll refer to this saved Quicktime file as the ‘Animation movie’.

If you had audio in the original video clip, and want to put it into the stylized video,
you can do it in the following way:

From Quicktime Pro menu select,
‘File’ - ‘Open File’ and locate the AIFF file that was saved in Step 1.
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Click on the ‘Animation movie’ window to make it active.
Select ‘Edit’ - ‘Add to Movie’
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Save the file and you’re done.

With the popularity of YouTube, you can use this tutorial’s techniques to open up a
new way of expression. | hope that this has given you a new way to look at the
possibilities for using Photoshop to place it's mark on different media.

About Pencil Pixels
Pencil Pixels was established to accommodate the needs of photographers and corporate
clients with services for creating and enhancing digital images for presentations.

Our One-Click Actions for Photoshop are unique methods for transforming photo images into
easy and quick art styles. Visit www.PencilPixels.com for more information, Photoshop
Action sets, styles, frames, image viewers and lots of free stuff from Pencil Pixels.
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